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Introduction 

 

 

The Keysight 14565B Automation Interface is optimized for integrating the 

Keysight 14565B Device Characterization Software with the Keysight 
Wireless Test Manager (WTM). The Keysight 14565B Device Characterization 
Software adds current drain measurement capability to the WTM’s 
automated testing of wireless devices.  

In order to complete the integration, you will need the .NET development 
version of WTM. The run-time version of WTM is not sufficient to complete 
the integration process. The development version provides a Visual Basic 
.NET project that allows editing and writing new Test Steps for WTM. To see 
what versions of the WTM are available, go to 
https://www.keysight.com/find/wtmanagers  

There are two steps that need to be completed in order to use the Keysight 
14565B Automation Interface in WTM. 

• The first step is to add a new instrument to WTM. A new instrument is 

just a WTM compatible driver and in this case this will be an Keysight 
14565B Automation Interface wrapper named 
Agilent.WTM.ag14565BMoM.dll. 

• The second step is to add Test Steps that will use the Keysight 14565B 
Automation Interface through the driver added in step 1.  An example of 
a test step is to set up and start data logging. 

 

NOTE You can contact Keysight Technologies at one of the following telephone 

numbers for warranty, service, or technical support information. 

In the United States: (800) 829-4444 

In Europe: 31 20 547 2111 

In Japan: 0120-421-345 

Or use our Web link for information on contacting Keysight in your 

country or specific location: www.keysight.com/find/assist 

Or contact your Keysight Technologies Representative.  

The web contains the most up to date version of this manual. Go to 

http://www.keysight.com/find/14565B to get the latest version of the 

manual. 

https://www.keysight.com/en/pc-1000002297%3Aepsg%3Apgr/wireless-test-managers?nid=-33747.0.00&cc=MY&lc=eng&cmpid=95388
http://www.keysight.com/find/assist
http://www.keysight.com/find/14565B
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Getting Started 

Adding the Keysight 14565B to the Wireless Test Manager ...........7 

Adding the Provided Keysight 14565B Test Steps to the Wireless Test 

Manager ......................................................................................... 11 

Run the Wizard to Complete Adding the Keysight 14565B to the 

Wireless Test Manager .................................................................. 13 
 

 

The Keysight 14565B Automation Interface provides a separate driver for 
Wireless Test Manager that follows the schema of other WTM instrument 
drivers. It provides almost all the same functions as the standard Keysight 
14565B Automation Interface except they are categorized.
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Adding the Keysight 14565B to the Wireless Test Manager 

The driver can be found in the following directory: My 
Documents\Keysight\14565B\Development\14565B Examples.zip\WTM 
Driver\. 

1. Open the WTM development solution using Visual Studio .Net 2003 or Visual 
Studio 2005. By default, the WTM installation places a shortcut to the 
solution on the desktop. In this example the solution was opened from the 
desktop by double-clicking Project for E6566C GSM GPRS EGPRS. This is a 
shortcut to [WTM Install Folder]\[WTM Version]\Development\ E6566C GSM 
GPRS EGPRS SAM Net.sln. The default WTM install folder is C:\Program 
Files\Keysight\WirelessTestManager\[WTM version]\.  

2. Right click inside the Toolbox panel in Visual Studio and click on Choose 

Items (VS2005) or Add Remove Items (VS2003). If the Toolbox is not visible, 
add it from the View menu.  

Visual Studio 2005   Visual Studio 2003 

3. On the .NET tab, click the Browse button and select the file 
Agilent.WTM.ag14565BMoM.dll from My Documents\Keysight 
\14565B\Development\14565B Examples.zip\WTM Driver\. Then click Open. 
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After clicking Open, the ag14565BControl should appear in the list of .NET 

Framework Components. Click OK.  
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4. From the Solution Explorer, open frmMain.vb in Designer view. The Solution 
Explorer is the solution and project file view. If it is not visible, you may 
enable it from the View menu.  

 

5. Open the Toolbox. The ag14565BControl should now appear in the General 
Tab of the Toolbox. Drag the ag14565BControl component from the Toolbox 
to the non-visual components bar of the form, found on the bottom of the 
window (where the other instrument drivers reside). 
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6. In the properties of the newly added component, change the name from 
Ag14565BControl1 to ag14565B. This name is required to be exactly 
ag14565B if you plan on using the provided 14565B WTM test steps. Note 

that the name is case sensitive. Save frmMain.vb.  

To finalize adding a new instrument, you would normally run the WTM Add 
Instrument Control wizard at this time. Before continuing with the wizard 
however, the 14565B Test Steps class module must be added first.  
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Adding the Provided Keysight 14565B Test Steps to the Wireless Test 

Manager 

This procedure will add the 14565B Test Steps to WTM. The process involves 
adding the test step source file to the WTM development project and aligning 
the WTM database with the source code using the provided wizard. The 
alignment process involves parsing each file for WTM generated comments 
containing information such as test step specifications and parameters. 

1. Copy the 14565B Test Steps source file from My Documents\Keysight\ 
14565B\Development\14565B Examples.zip\WTM Test Steps\ 
Agilent14565BMeasSteps.vb to [WTM Install Folder]\Development\. 

The default WTM install folder is C:\Program Files\Keysight\ 

WirelessTestManager\[WTM version]\. 

2. In the WTM development project, from the Solution Explorer, right-click on 

the project name and click Add->Add Existing Item. Then choose the newly 
copied Test Steps source file Agilent14565BMeasSteps.vb. 

 

3. Click on the Keysight Add Wireless Test wizard button found in the Visual 
Studio toolbar. If the Wireless Test Manager wizard buttons are missing, 
right-click on the toolbar and enable WTM Controls. If WTM Controls is 
missing from the list, try reinstalling WTM. 

On the first page of the wizard locate the WTM database file you want to use.  

The default location for database files is [WTM Install Folder]\[WTM 
Version]\Development\TestData\. The default WTM install folder is 
C:\Program Files\Keysight\WirelessTestManager\ [WTM version]\. Then click 
Next. 
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4. On the next screen choose Align database to test code. Click Next and let the 

wizard complete the alignment. Click Finish when done.  

 

5. The final window will ask about updating the database revision number and 
viewing the database alignment log file. You may uncheck the view the log 
file. Click Finish. When prompted for a new database revision number, 
increment the last digit of the revision by 1. For example if the old database 
revision is 1.0.0, enter 1.0.1. Click Ok. Save All. 
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Run the Wizard to Complete Adding the Keysight 14565B to the Wireless 

Test Manager 

The Add Instrument Control wizard lets you choose the instrument name and 
what test class modules (the source files) need the instrument  

1. Click on the Keysight WTM Add Instrument Control wizard button. This opens 
a wizard that will guide you through adding a new instrument:  

 

2. Choose Add Instrument and click on Next. In the next window you should see 

the newly added Keysight 14565B. Select it and click on Next.  

 

3. In the next window type a UI name (the name that will appear in the WTM 
Instrument Control window), keep the code name as ag14565B, and select 
the Agilent14565BMeasSteps test class module to use the Keysight 14565B.  
The code name corresponds to the name of the ag14565BControl toolbox 
component that was added earlier.  
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Click on Next. At this point the wizard will add the ag14565B instrument 
driver to frmMain and also give access to the instrument in the 
Agilent14565BMeasSteps class. When the process is complete you will see 
the following message:  

Click OK, then click Finish when the original wizard window reappears. 

4. Now build and run the WTM project. Both of these tasks can be done by 
clicking the Start Button found on the toolbar.  

 

After a successful compilation, the modified WTM software will execute. After 
WTM loads click the Change Configuration tab. Then click on Instrument 
Control in the list on the left. You should see the Keysight 14565B as one of 
the instruments. When you click the Define Test Plan tab, you should see the 
new 14565B test steps. 



Maintenance     6 

Keysight 14565B WTM Programming Guide 15

  

 

NOTE If you search for all instances of the string “ag14565B” in the project files 

you will see how WTM initializes the instrument and how the test plans 

have access to the instrument. In most cases it is recommended that the 

WTM wizards found in the toolbar of Visual Studio be used for common 

WTM tasks.  

NOTE Wireless Test Manager comes with a power supply driver named 

663NNX PS in the software and PowerSupply in the source code. Some 

of the Test Steps that come with WTM use this power supply driver. It is 

recommended that you check if a Test Step you are using has calls to 

PowerSupply and that you do not add that Test Step in between 

ag14565BxBegin and ag14565BxEnd Test Steps that may be Data 

Logging or doing a CCDF histogram. 

 



 

    

3 

Using Test Steps 

Using the Provided Keysight 14565B Test Steps ......................... 17 

Test Step Examples ....................................................................... 27 

Test Step Example Using the Keysight Wireless Test Manager ... 30 

 

 

 

The programming examples in this chapter describe how to program the 
Keysight 14565B Device Characterization Software from within the Keysight 
Wireless Test Manager. Test step examples are explained in detail. Source 
code for a sample WTM test step is included at the end of the chapter.
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Using the Provided Keysight 14565B Test Steps  

The provided test steps found in My Documents\Keysight\14565B\ 
Development\14565B Examples.zip\WTM Test Steps\ 
Agilent14565BMeasSteps.vb allow for the use of the four acquisition modes 
found in the Keysight 14565B: Current Waveform, Voltage Waveform, CCDF, 
and Data Logging. The Test Steps included are: 

1. ag14565B CCDF Begin 

2. ag14565B CCDF End 

3. ag14565B CCDF Get Measurements 

4. ag14565B Data Logging Begin 

5. ag14565B Data Logging End 

6. ag14565B Data Logging Get Measurements 

7. ag14565B Data Logging Insert Event Tag 

8. ag14565B Setup Power Supply 

9. ag14565B Waveform Capture  

10.ag14565B Waveform Get Measurements  

 

The Test Steps are described in detail in the following tables. 
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ag14565B CCDF Begin 

This step is used to setup and start a CCDF acquisition in 14565B. 

 

Properties Description 

ag14565B Acquisition Hours CCDF Acquisition Period Hours 

ag14565B Acquisition Minutes Acquisition Period Minutes 

ag14565B Acquisition Seconds Acquisition Period Seconds 

ag14565B CCDF Sense Type Acquisition Sense Type 

Enumerated Values: 

ag14565B CCDF Sense Type Voltage (0) 

ag14565B CCDF Sense Type Current (1) 

ag14565B CCDF Sense Type DVM (2) 

ag14565B CCDF End 

This step is used to wait for the CCDF acquisition to finish after a call to 
CCDF Begin. When the test plan gets to this test step it can halt and display 
the time remaining in the acquisition at the bottom of the screen or it can 
stop right away. This step can also save the acquired CCDF graph to a file. 

 

Properties Description 

ag14565B Save Directory The directory where the file will be saved. This is 

relative to the 14565B Working Folder set under 

Preferences in the Keysight 14565B software. 

You can also specify an absolute path. 

ag14565B Save Filename The filename without the file extension of the 

waveform to be saved. 

ag14565B Save Filename 

Include Timestamp 

Adds a %t to the filename string signifying to 

the 14565B to insert the start date-time stamp 

in that place. 

Enumerated Values: 

ag14565B No (0) 

ag14565B Yes (1) 

ag14565B Save To A File Whether or not to save the acquisition to a file. 

Enumerated Values: 

ag14565B No (0) 

ag14565B Yes (1) 

ag14565B Wait for Acquisition 

to Finish 

Whether to wait for the acquisition to finish or 

stop the acquisition when it gets to this stop test 

step. 

Enumerated Values: 

ag14565B No (0) 

ag14565B Yes (1) 
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ag14565B CCDF Get Measurements 

This step is used to retrieve the measurements from 14565B after a CCDF 
acquisition. 

 

Properties Description 

ag14565B 0point1th Percentile 

Value 

Value of the CCDF Graph at 0.1th 

Percentile 

ag14565B 10th Percentile 

Value 

Value of the CCDF Graph at 10th 

Percentile 

ag14565B 1st Percentile Value Value of the CCDF Graph at 1st Percentile 

ag14565B Average Percentile Percentile of the Average on the CCDF 

Graph 

ag14565B Average Value Value of the Average Value on CCDF 

Graph 

ag14565B Maximum Value Maximum Value on the CCDF Graph 

 

Properties Description 

ag14565B Results Label Acquisition Text Label that will be placed 

next to each result returned by this test 

step in the WTM Results table. This 

allows for easier parsing of the results 

table 

ag14565B Data Logging Begin 

This step is used to setup and start a Data Logging acquisition in 14565B. 

 

Properties Description 

ag14565B Acquisition Hours 

Dlog 

Acquisition Period Hours 

ag14565B Acquisition Minutes Acquisition Period Minutes 

ag14565B Acquisition Seconds Acquisition Period Seconds 

ag14565B Dlog Integration 

Time 

Data Logging Integration Time. 

See the 14565B Help File – under Long-

Term Data Logging for more information. 

ag14565B Dlog Sense Type 

 

Acquisition Sense Type 

Enumerated Values: 

ag14565B Dlog Sense Type Current (0) 

ag14565B Dlog Sense Type Current and 

Voltage (1) 

ag14565B Dlog Sense Type Current and 

DVM (2) 
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ag14565B Data Logging End 

This step is used to wait for the Data Logging acquisition to finish after a call 
to Data Logging Begin. When the test plan gets to this test step it can halt 
and display the time remaining in the acquisition at the bottom of the screen 
or it can stop right away. This step can also save the acquired Data Logging 
waveform to a file. 

 

Properties Description 

ag14565B Save Directory The directory where the file will be saved. This 

is relative to the 14565B Working Folder set 

under Preferences in the Keysight 14565B 

software. You can also specify an absolute 

path. 

ag14565B Save Filename The filename without the file extension of the 

data log to be saved. 

ag14565B Save Filename Include 

Timestamp 

Adds a %t to the filename string signifying to 

14565B to insert the start date-time stamp in 

that place. 

Enumerated Values: 

ag14565B No (0) 

ag14565B Yes (1) 

ag14565B Save To A File Whether or not to save the acquisition to a file. 

Enumerated Values: 

ag14565B No (0) 

ag14565B Yes (1) 

ag14565B Wait for Acquisition to 

Finish 

Whether to wait for the acquisition to finish or 

stop the acquisition when it gets to this stop 

test step. 

Enumerated Values: 

ag14565B No (0) 

ag14565B Yes (1) 
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ag14565B Data Logging Get Measurements 

This step is used to retrieve the measurements from 14565B after a Data 
Logging acquisition. 

 

Properties Description 

ag14565B Average Value Average Measurement of the Data Log waveform 

ag14565B Maximum Value Maximum Measurement of the Data Log 

waveform 

ag14565B Minimum Value Minimum Measurement of the Data Log 

waveform 

 

Properties Description 

ag14565B Dlog Get Meas 

Type 

The measurement type to retrieve from the Data 

Log waveform. Note: If the ag14565B Dlog Sense 

Type property in ag14565B Data Logging Begin is 

set to ag14565B Dlog Sense Type Current, you can 

only retrieve Current in this property. 

Enumerated Values:  

ag14565B Get Meas Type Current (0),  

ag14565B Get Meas Type Voltage (1),  

ag14565B Get Meas Type Power (2) 

ag14565B Results Label 

 

Text Label that will be placed next to each result 

returned by this test step in the WTM Results table. 

This allows for easier parsing of the results table. 

 

ag14565B Data Logging Insert Event Tag 

This step is used to insert an event tag into a running data log waveform. Use 
this to label parts of your waveform in real-time with meaningful descriptions 
while executing the Test Plan. 

 

Properties Description 

ag14565B Dlog Event Tag Label A text label for the event tag. 
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ag14565B Setup Power Supply 

This test step sets up the 663xx power supply connected to 14565B. Call this 
test step before making a call to ag14565B Data Logging Begin, ag14565B 
CCDF Begin, or ag14565B Waveform Capture test steps to setup the power 
supply and turn on the Device Under Testing. Note that you must call this 
function every time you switch to a different 14565B Acquisition mode. See 
the property ag14565B Acquisition Mode below. 

 

Properties Description 

ag14565B Acquisition Mode Set this to the 14565B acquisition mode you 

plan using in the subsequent Begin/Capture 

test step. For example, you have to set this 

property to ag14565B CCDF Acquisition if 

you want to set up the power supply before 

calling ag14565B CCDF Begin test step. 

Similarly, you set this property to ag14565B 

Data Logging Acquisition before making a 

call to ag14565B Data Logging Begin. This is 

necessary because the different acquisition 

modes have parameters like Current Type 

and Current Range passed in differently.  

Enumerated Values:  

ag14565B Current Waveform (0) 

ag14565B Voltage Waveform (1) 

ag14565B CCDF Acquisition (2) 

ag14565B Data Logging Acquisition (3) 

ag14565B Reset 14565B and 

Power Supply 

Reset the power supply and the 14565B 

software state. 

ag14565B IO Timeout Instrument IO Timeout 

ag14565B Output 1 Enabled Set the output state of the channel.  

Enumerated Values:  

ag14565B No (0) 

ag14565B Yes (1) 

ag14565B Output 1 Setup Whether or not the output state of the 

channel will be changed.  

Enumerated Values:  

ag14565B No (0) 

ag14565B Yes (1) 

ag14565B Output 2 Enabled Set the output state of the channel.  

Enumerated Values:  

ag14565B No (0) 

ag14565B Yes (1) 

 

Properties Description 

ag14565B Output 2 Setup Whether or not the output state of the 

channel will be changed.  

Enumerated Values:  

ag14565B No (0) 

ag14565B Yes (1) 

ag14565B Output Channel 1 

Relay Mode 

Set the mode of the relay of the channel. 

Note: The power supply has to the have the 
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Relay option installed to set a value other 

than ag14565B Output Relay Mode Not 

Available.  

Enumerated Values:  

ag14565B Output Relay Mode DD (0) 

ag14565B Output Relay Mode HD (1) 

ag14565B Output Relay Mode DH (2) 

ag14565B Output Relay Mode HH (3) 

ag14565B Output Relay Mode Not Available 

(4) 

ag14565B Output Channel 2 

Relay Mode 

Set the mode of the relay of the channel. 

Note: The power supply has to the have the 

Relay option installed to set a value other 

than ag14565B Output Relay Mode Not 

Available.  

Enumerated Values:  

ag14565B Output Relay Mode DD (0) 

ag14565B Output Relay Mode HD (1) 

ag14565B Output Relay Mode DH (2) 

ag14565B Output Relay Mode HH (3) 

ag14565B Output Relay Mode Not Available 

(4) 

ag14565B Output Compensation 

Mode 

Set the compensation mode of the power 

supply. For more information, see the power 

supply manual.  

Enumerated Values:  

ag14565B Output Compensation Mode 

LLOCAL (0) 

ag14565B Output Compensation Mode 

HLOCAL (1) 

ag14565B Output Compensation Mode 

LREMOTE (2) 

ag14565B Output Compensation Mode 

HREMOTE (3) 

ag14565B Output Coupling Set the output coupling on or off.  

Enumerated Values:  

ag14565B No (0) 

ag14565B Yes (1) 

 

Properties Description 

ag14565B Prompt Output On and 

Turn On DUT 

Whether or not to show the prompts 

displaying the power supply settings right 

before Output ON and to turn on the Device 

Under Testing.  

Enumerated Values:  

ag14565B No (0) 

ag14565B Yes (1) 

ag14565B Sense Current Range Set the sense current range. 

Enumerated Values:  

ag14565B Sense Current Range High (0) 

ag14565B Sense Current Range Medium (1) 

ag14565B Sense Current Range Low (2) 

ag14565B Sense Current Type Set the sense current range. 

Enumerated Values:  
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ag14565B Sense Current Type ACDC (0) 

ag14565B Sense Current Type DC (1) 

ag14565B Sense Protection 

Enabled 

Enable/Disable the sense protection. 

Enumerated Values:  

ag14565B No (0) 

ag14565B Yes (1) 

ag14565B Sense Window Set the sense window. 

Enumerated Values:  

ag14565B No (0) 

ag14565B Yes (1) 

ag14565B Source Channel 1 

Current Limit 

Channel 1 Current Limit. 

ag14565B Source Channel 1 OVP 

Limit 

Channel 1 OVP Limit. 

ag14565B Source Channel 1 

Resistance Value 

Channel 1 Resistance Level. Set this property 

to ag14565B Yes if this channel has 

resistance capability. 

ag14565B Source Channel 1 

Resistance Capability 

Whether or not this channel has resistance 

capability. 

Enumerated Values:  

ag14565B No (0) 

ag14565B Yes (1) 

ag14565B Source Channel 1 

Voltage Level 

Channel 1 Voltage Level. 

ag14565B Source Channel 2 

Current Limit 

Channel 2 Current Limit.   

ag14565B Source Channel 2 

Voltage Level 

Channel 2 Voltage Level. 

ag14565B Waveform Capture 

This step sets up and starts a Current or Voltage Waveform in 14565B. You 
may set an instantaneous or a triggered waveform. 

 

Properties Description 

ag14565B Waveform Mode Voltage or Current Waveform capture mode 

in 14565B. 

Enumerated Values:  

ag14565B Current Waveform (0) 

ag14565B Voltage Waveform (1) 

ag14565B Capture Length The time of the captured waveform. This value 

determines the rate and number of points. 

The max rate is 64kHz and the max points are 

4096.  

Enumerated Values:  

ag14565B Capture Length 600 us (0) 

ag14565B Capture Length 1200 us (1) 

ag14565B Capture Length 3000 us (2) 

ag14565B Capture Length 6 ms (3) 

ag14565B Capture Length 12 ms (4) 

ag14565B Capture Length 30 ms (5) 
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ag14565B Capture Length 60 ms (6) 

ag14565B Capture Length 120 ms (7) 

ag14565B Capture Length 300 ms (8) 

ag14565B Capture Length 600 ms (9) 

ag14565B Capture Length 1200 ms (10) 

ag14565B Capture Length 3000 ms (11) 

ag14565B Capture Length 6 s (12) 

ag14565B Capture Length 12 s (13) 

ag14565B Capture Length 24 s (14) 

ag14565B Trigger Delay Set the position of the pre-trigger based on 

the total capture length. The delay is the 

percentage of the capture length. For 

example, if the ag14565B Capture Length was 

set to 30 ms and ag14565B Trigger Delay was 

set to 10, the pre-trigger would be set at 3ms 

before t = 0 (30ms * 10%).   

ag14565B Trigger Hysteresis The hysteresis value of the level trigger. 

ag14565B Trigger Level The level of the trigger. 

ag14565B Trigger Mode The trigger mode.  

Enumerated Values:  

ag14565B Auto Trig (0) 

ag14565B Positive Slope (1) 

ag14565B Negative Slope (2) 

ag14565B Either Slope (3) 

ag14565B External (4) 

ag14565B Waveform Get Measurements 

Retrieve the measurements from 14565B after a Waveform Capture. 

 

Properties Description 

ag14565B Average Value Average Measurement of the waveform. 

ag14565B High Value High Measurement of the waveform. 

ag14565B Low Value Low Measurement of the waveform. 

ag14565B Maximum Value Maximum Measurement of the waveform. 

ag14565B Minimum Value Minimum Measurement of the waveform. 

 

Properties Description 

ag14565B Results Label Text Label that will be placed next to each 

result returned by this test step in the WTM 

Results table. This is to allow for easier 

parsing of the results table. 

ag14565B Save Directory The directory where the file will be saved. This 

is relative to the 14565B Working Folder set 

under Preferences in the Keysight 14565B 

software. You can also specify an absolute 

path. 

ag14565B Save Filename The filename without the file extension of the 

waveform to be saved. 

ag14565B Save Filename Include 

Timestamp 

Adds a %t to the filename string signifying to 

14565B to insert the start date-time stamp in 
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that place.  

Enumerated Values:  

ag14565B No (0) 

ag14565B Yes (1) 

ag14565B Save To A File Whether or not to save the acquisition to a 

file. 

Enumerated Values:  

ag14565B No (0) 

ag14565B Yes (1) 
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Test Step Examples 

Example #1 

Set the power supply to 3.6V, set the cell phone to some state, and measure 
current for 45 seconds. Get the average current. Save the entire 5 minute 
waveform for later analysis. 

Properties 

The properties of the test steps are as follows. Note that the default test step 
properties are not shown. 

 

Properties Description 

ag14565B Setup Power Supply Acquisition Mode: Data Logging 

Reset: Yes 

Output 1 Enabled: Yes 

Output 1 Setup: Yes 

Output 1 Voltage Lev.: 3.6 V 

GPRS (or other cell phone state 

command) 

Turn on the phone and set it to some state. 

ag14565B Data Logging Begin Acquisition Seconds: 45 seconds 

Integration Time: 5 ms 

Sense Type: Current 

ag14565B Data Logging End Wait for Acquisition to finish: Yes 

Save to a file: Yes 

ag14565B Data Logging Get 

Measurements 

Dlog Get Meas Type: Current 

Results 
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Example #2 

Set the power supply to 3.6V and set the cell phone to some state. Start a 
loop that will iterate 10 times over some parameter in a cell phone. Measure 
current for 35 seconds during each loop iteration and get the average 
current. 

Properties 

The properties of the test steps are as follows. Note that the default test step 
properties are not shown. 

 

Properties Description 

ag14565B Setup Power Supply 
Acquisition Mode: CCDF 

Reset: Yes 

Output 1 Enabled: Yes 

Output 1 Setup: Yes 

Output 1 Voltage Lev.: 3.6 V 

GPRS (or other cell phone state 

command) 

Turn on the phone and set it to some state 

Start Loop Loop 10 times, possibly change a cell phone 

state 

GPRS (or other cell phone state 

command) 

Change some cell phone state 

ag14565B CCDF Begin Acquisition seconds: 35 seconds 

Sense type: Current 

ag14565B CCDF End Wait for Acquisition to finish: Yes 

Save to a file: No 

ag14565B CCDF Get 

Measurements 

Display the current measurements 

End Loop  

Results 
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Example #3 

Set the power supply to 3.6V and set the cell phone to some state. Change 

the cell phone state and capture a 600ms current waveform when the 
current level goes above exactly 200 mA. 

Properties 

The properties of the test steps are as follows. Note that the default test step 
properties are not shown. 
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Properties Description 

ag14565B Setup Power Supply Acquisition Mode: CCDF 

Reset: Yes 

Output 1 Enabled: Yes 

Output 1 Setup: Yes 

Output 1 Voltage Lev.: 3.6 V 

GPRS (or other cell phone state 

command) 

Turn on the phone and set it to some state 

ag14565B Waveform Capture Waveform Mode: Current Waveform 

Capture Length: 600 ms 

Trigger Hysteresis: 0.01 A 

Trigger Level: 0.2 A 

Trigger Mode: Positive slope 

GPRS (or other cell phone state 

command) 

Change some cell phone state 

ag14565B Waveform Get 

Measurements 

Display the current measurements 

Results 

 

Test Step Example Using the Keysight Wireless Test Manager 

This section is intended for users who plan to write new test steps for use 

with the Keysight 14565B. 

To show an example of how the Keysight 14565B would be used in a test 
steps, we will create a new test class module using the Keysight Add 
Wireless Test wizard. Name the new test class module “Agilent14565BSteps” 
and the new test step “DataLoggingStart”.  This will create the source file 
Agilent14565BSteps.vb and the function named DataLoggingStart. The 
source code for Agilent14565BSteps.vb is as follows: 
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Program Code  

 
'© Copyright 2006 Keysight Technologies, Inc.  

   

Option Strict On  

Option Explicit On  

   

    Friend Class Agilent14565BSteps 

      

    ' WIZARD GENERATED CLASS, DO NOT REMOVE THIS LINE  

   

    Private TestData As Agilent.WTM.Exec.IExecTestData  

    Private Message As Agilent.WTM.Exec.IExecTextMessage  

    Private FlowControl As Agilent.WTM.Exec.IExecFlowControl  

    Private DataLogging As Agilent.WTM.Exec.IExecDataLogging  

    Private ExecUtils As Agilent.WTM.Exec.IExecUtilities  

    Private DUTControl As Agilent.WTM.Exec.IExecDutControl  

    Private FixtureControl As Agilent.WTM.Exec.IExecFxtControl  

    Private LoopingControl As Agilent.WTM.Exec.IExecLooping  

    Private PathOffset As Agilent.WTM.Exec.IExecPathOffset  

    Private LocalApplication As Agilent.WTM.Exec.IExecLocalizeApp  

    Private ag14565B As Agilent.WTM.ag14565BMoM.ag14565BControl 

  

    Friend Sub Resource(ByRef VDataExec As Agilent.WTM.Exec.ExecControl, ByRef 

VDataInstruments As SortedList)  

        

'''''''''''''''''''''''''''''''''''''''''''''''''''''''''''''''''''''''''''''  

        '  

        ' Original Date: 8/8/2006 11:37:52 AM  

        ' Revision Date:  

        '  

        ' Author: Keysight  

        '  

        ' Description:  

        '    This method must be called by the application program.  

        '    For example:  cdmaCallProcessing.Resource Exec, Instruments  

        '    For example:  cdmaCallProcessing.Resource Exec, Instruments  

        '  

'''''''''''''''''''''''''''''''''''''''''''''''''''''''''''''''''''''''''''''  

        TestData = VDataExec.WTMTestData  

        Message = VDataExec.WTMTextMessage  

        FlowControl = VDataExec.WTMFlowControl  

        DataLogging = VDataExec.WTMDataLogging  

        ExecUtils = VDataExec.WTMUtilities  

        DUTControl = VDataExec.WTMDUTControl  

        FixtureControl = VDataExec.WTMFixtureControl  

        LoopingControl = VDataExec.WTMLoopingControl  

        PathOffset = VDataExec.WTMPathOffset  

        LocalApplication = VDataExec.WTMLocalizeApplication  

        ag14565B = DirectCast(VDataInstruments.Item("ag14565B"), 

Agilent.WTM.ag14565BMoM.ag14565BControl) 

    End Sub 

   

    Protected Overrides Sub Finalize()  

        MyBase.Finalize()  

    End Sub  

   

   Public Sub DataLoggingStart()  

        

'''''''''''''''''''''''''''''''''''''''''''''''''''''''''''''''''''''''''''''  
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        '  

        ' Original Date: 8/8/2006 11:37:52 AM  

        ' Revision Date:   

        ' Revision: 1.0  

        ' Author: Keysight  

        '  

        ' Test Description:  

        '     This step begins data logging.  

        '  

        ' WIZARD GENERATED COMMENTS BELOW, DO NOT MODIFY  

        '  

        ' Test Name: Data Logging Start  

        ' Test Class Name: Agilent14565BSteps  

        ' Test Group: Keysight 14565B  

        ' Format Standard: All  

        '  

        ' Parameters Used:  

        '    Name: Sense Type  

        '       Units:   

        '       DataType: OOM or Integer Enum  

        '       Default Value: Current  

        '       Range: Current (0), Current and Voltage (1), Current and DVM (2)  

        '    Name: Integration Time  

        '       Units:   

        '       DataType: Double  

        '       Default Value: .005  

        '       Range: .005 to 1  

        '    Name: Seconds  

        '       Units:   

        '       DataType: Integer  

        '       Default Value: 35  

        '       Range:   

        '    Name: Minutes  

        '       Units:   

        '       DataType: Integer  

        '       Default Value: 0  

        '       Range:   

        '    Name: Hours  

        '       Units:   

        '       DataType: Integer  

        '       Default Value: 0  

        '       Range:   

        '  

'''''''''''''''''''''''''''''''''''''''''''''''''''''''''''''''''''''''''''''  

   

        ' Dimension parameters  

        Dim SenseType As Integer  

        Dim IntegrationTime As Double  

        Dim Seconds As Integer  

        Dim Minutes As Integer  

        Dim Hours As Integer  

   

        Try  

              ' Find the parameter values from the data store  

            With TestData  

                SenseType = .FindParmEnum("Sense Type")  

                IntegrationTime = cDbl(.FindParm("Integration Time"))  

                Seconds = cInt(.FindParm("Seconds"))  

                Minutes = cInt(.FindParm("Minutes"))  

                Hours = cInt(.FindParm("Hours"))  

            End With  
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            If Not FlowControl.RepeatingTest Then  

 

            End If 

            'This section would probably be done in another step 

'The code is here to provide more function call examples 

            ' Reset, Set Channel 1 = 3.6V, Max Curr, Output On 

            ag14565B.Utility.Reset() 

            

ag14565B.Source.SetVoltageLevel(Agilent.WTM.ag14565BMoM.ag14565BChannelEnum.ag145

65BChannel1, 3.6) 

            

ag14565B.Source.SetCurrentLimit(Agilent.WTM.ag14565BMoM.ag14565BChannelEnum.ag145

65BChannel1, ag14565B.Utility.QueryCurrentLimitMax()) 

            

ag14565B.Output.SetEnabled(Agilent.WTM.ag14565BMoM.ag14565BChannelEnum.ag14565BCh

annel1, True) 

 

            ' Pause and turn on dut 

 

            ag14565B.Measurement.Dlog.SetupDlogAcq(CType(SenseType, 

Agilent.WTM.ag14565BMoM.ag14565BDlogSenseTypeEnum), Hours, Minutes, Seconds, 

IntegrationTime) 

            ag14565B.Measurement.StartMeasurement() 

            TestData.PrintMessage("Data Logging Started") 

            ' Initiate the measurement  

            ' TODO: Add code to initiate the measurement here  

            'Fetch and Compare measurement results to the given specification  

   

            '''''''''''''''''''''''''''''''''''''''''''''''''''''''''''  

            ' TODO: Make Measurements here using the following objects:  

            '       TestData  

            '       Message  

            '       FlowControl  

            '       DataLogging  

            '       Utilities  

            '       DUTControl  

            '       FixtureControl  

            '       and the appropriate COM objects for Methods of Measurement or 

PnP drivers  

            '''''''''''''''''''''''''''''''''''''''''''''''''''''''''''  

   

        Catch ex As Exception  

            TestData.LogErrorMessage(SAMUtils.ParseErrLN(ex))  

            FlowControl.AbortTestPlan = True  

        End Try  

   

    End Sub  

End Class 
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Analysis 

The main thing to note here is how to convert test parameters picked from 
the WTM GUI to enumerated parameters used in the 14565B function calls. 
For example, one of the test parameters is Sense Type. In the Keysight Add 
Wireless Test wizard, this parameter was setup to be OOM with driver enum 
(which stands for One of Many, with a numerical meaning behind every 
choice). The choices look like this: 

'    Name: Sense Type  

'       Units:   

'       DataType: OOM or Integer Enum  

'       Default Value: Current  

'       Range: Current (0), Current and Voltage (1), 

Current and DVM (2)  

In the beginning of the DataLoggingStart function you can see the Sense 
Type parameter being assigned to a local integer variable using the following 
code: 

SenseType = .FindParmEnum("Sense Type") 

A few lines down is the function call to set up data logging. The code is as 
follows: 

ag14565B.Measurement.Dlog.SetupDlogAcq(CType(SenseType, 

Agilent.WTM.ag14565BMoM.ag14565BDlogSenseTypeEnum), Hours, 

Minutes, Seconds, IntegrationTime) 

The first parameter of SetupDlogAcq() is an enum type named 

Agilent.WTM.ag14565BMoM.ag14565BDlogSenseTypeEnum. In order to 
pass SenseType as the first argument of the function call, you have to cast it 
to the enum type. This is done using the CType call: 

CType(SenseType, 

Agilent.WTM.ag14565BMoM.ag14565BDlogSenseTypeEnum) 

For this to work properly, Sense Type has to be an integer-storing type (int, 
long, short) and have its values correspond to the enum type values. This 
means that when adding a OOM parameter to a Test Step, you should refer 
to the definition of the enum the parameter will represent. Look in the 
Automation Interface Help for the list of enumerations. 

So in this case, when adding Sense Type OOM parameter, you look at 

ag14565BdlogSenseTypeEnum: 

typedef enum { ag14565BDlogCurr = 0,  

ag14565BDlogCurrVolt, ag14565BDlogCurrDVM } 

ag14565BDlogSenseTypeEnum; 

and have the Sense Type OOM parameter represent the same values as the 
enum (Current = 0, Current & Volt = 1, Current & DVM = 2). 
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